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Kameleon Presenter
User Guide & Reference
Chameleon AI IDE · v2.2

Kameleon Presenter is a live, multi-modal presentation engine built inside Chameleon AI IDE. Unlike

traditional slide tools it treats every object on screen as a live actor — a phone feed, a running PDF, a

drawing board, a website mirror — all animatable and fully controllable by AI in real time.

This guide covers the Stage, the Dresser, every object type, the Cue System, the Timeline, animations,

the navigation focus system, Present Mode, AI-assisted control, and split-stage layouts.
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1. Core Concepts

1.1 The Theatre Metaphor
Kameleon borrows vocabulary from theatre:

• Stage — the visible presentation canvas (1920 × 1080 logical pixels).

• Dresser — the off-stage panel on the left. Objects here are ready but invisible. Drag onto stage to bring
them on.

• Actor / Object — any item on stage: text box, image, phone feed, PDF…

• Cue — a scripted action (enter, exit, zoom, edit text, change layer…).

• Tank — a saved presentation file (.kpt) containing actors, cues, timeline, and assets.

1.2 Layers
Every actor sits in one of three Z-layers:

Layer Z range Typical use

BOTTOM 0–99 Backgrounds, slide imagery

MIDDLE 100–199 Primary content (default)

TOP 200–299 Overlays: ticker, timer, annotations

Within a layer use Raise / Lower / Bring Forward / Send Back from the right-click menu to fine-tune Z

order.
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2. Object Types

Type What it does

Rich Text Box HTML-formatted live text, editable on double-click. Bold/italic/colour/font-size formatting via
right-click menu.

Image Box Static image from file, URL, or base64. Supports KeepAspectRatio. The Add Image dialog
shows a live preview pane as you browse.

Video Box Video file playback at 25 fps. Play/pause/stop/seek/speed (0.5×–2×) and loop via right-click
or timeline cues. Prepare videos at 24 or 25 fps for smooth playback.

ADB Phone Live Android screen streamed via ADB at 25 fps. Touch injection available in Interact
Mode.

PPT Mirror Mirrors a desktop window (PowerPoint, LibreOffice, any app) via screen capture at 25 fps.

Window Capture Captures any named desktop window by title (Chrome, VLC, terminal, etc.). Optional
auto-launch command — Kameleon opens the app if the window is not already running.

PDF Box Renders PDF pages. Click object to focus, then ← → navigate pages. On-screen ■■

buttons also work.

Drawing Board Shared freehand canvas. Add Clear Cue sends a board-clear event to the timeline.

Ticker (H/V) Horizontal (right→left) or vertical (bottom→top) scrolling text banner. Up to 8 per stage.
Configurable speed.

Mind Map Node Rounded pastel card with editable label. Drag from the border to draw a connector:
release on empty canvas → new child node + connector; release on an existing node →
connector only. 8 pastel colours. Enter/Exit/Show/Hide cues supported.

Connector Bezier arrow between two actors. Direction (→ / ↔ / —), line colour, arrow colour, width
(1–6), and style (solid/dashed/dotted) all configurable at runtime. Show/Hide cues
supported.

Stack Sequence container for any objects. Click to focus, then ← → navigate slots. Auto-timer,
peer-push, and fullscreen modes.

2.1 Creating a Stack
A KameleonStack can be built in several ways from the Add Object menu in the Dresser toolbar:

Method How to use

■ Stack from Images… Pick multiple image files — each becomes one slot.

■ Stack from Folder… Pick a folder — every supported file becomes a typed slot. Files are sorted by numeric
prefix (e.g. 01-intro.png, 02-demo.mp4). Supported types: images, video, PDF,
text, HTML.

Drag & drop Drag objects from the Dresser into the Stack thumbnail strip.

Right-click object Build Stack… — converts the selected dresser objects into a stack.

Stack from Folder — naming convention: prefix files with a three-digit number followed by a separator:

NNN-name.ext, NNN_name.ext, or NNN name.ext. The prefix is stripped from the object name so the
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thumbnail strip stays readable. Files without a prefix sort after all numbered files, in alphabetical order.

Extension Object type created

.png .jpg .jpeg .bmp .gif .webp .tif .tiff Image Box

.mp4 .avi .mkv .mov .webm .m4v Video Box

.pdf PDF Box

.txt .md Rich Text Box (monospace pre-wrap)

.html .htm Rich Text Box (HTML rendered)

■ For a lecture with mixed content — title image, demo video, handout PDF, notes text — name them
01-title.png, 02-demo.mp4, 03-handout.pdf, 04-notes.txt in one folder and import them all in one click.

2.2 Resizing & Moving
Select any actor → drag the 8 handle squares to resize. Drag the body to move. Hold Shift while resizing

to constrain.

2.3 Right-Click Menu (all objects)

Menu item Effect

■ Return to Dresser Move off-stage without deleting

■ Delete Remove permanently

■ Maximize Fill the full stage (1920×1080). Click again to restore.

■ Rotate Content → Rotate painted content 0 / 90 / 180 / 270° inside the bounding box

▲▼ Layer controls Raise Layer / Lower Layer / Bring Forward / Send Back

■ Background Color Set actor background fill

■ Background Image Set actor background pixmap

■ Frame Color Set border colour and width

■ Enter Animation → Choose or record the entrance animation

■ Exit Animation → Choose or record the exit animation

✦ Preview → Fire a one-shot animation preview (non-destructive)

2.4 Dresser Panel — Right-Click Menu
Right-clicking any item in the Dresser list opens a context menu:

Action Effect

■ Preview (center stage) Places the object at stage centre with no animation — for checking its size before
assigning a pick-target. Right-click → ■ Return to Dresser when done.

■ Duplicate Creates a copy (same type, size, content, and animation bindings). Name appended
with ' (copy)'.
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■ Reserve / Unreserve Toggles a reserved state — the item stays in the dresser but is rendered grey with a
■ prefix to signal 'held / not ready'. Useful for slot-planning.

✕ Remove Stops any live capture (ADB / Video) and removes the object from the scene
permanently.

■ Use Preview (center stage) to check that an ADB phone or Video widget is the right size before recording a
pick-target. The object lands at centre with no fly-in animation, so you can resize it freely before sending it back to
the dresser.

2.4 ADB Phone — Interact Mode
Double-click the ADB actor to toggle Interact Mode (green border). In interact mode:

• Single click → tap on phone

• Click-hold > 600 ms → long press

• Click-drag → swipe

• Esc → Android Back button

• Home → Android Home button

• Menu → Recent Apps

■ Touch mapping stays accurate because Kameleon reads the physical screen resolution directly from the
connected device.

2.5 ADB Phone — Timeline Cues
Right-click any ADB Phone actor → ■ Add Cue to Timeline… to stamp a timed action at the current

playhead position:

Cue What it does

■ Restart Stream Stops and restarts the ADB video capture pipeline. Useful after the device screen locks or
the connection drops.

■ Open URL… Opens any URL in the device's default browser. Prompt asks for the URL; stored in the
cue parameters.

■ Launch App… Launches an installed app by package name using the Android LAUNCHER intent.
Example: com.google.android.youtube.

■ ADB cues fire via the spacebar cue queue and the timeline playback — add them at precise timestamps to
synchronise phone content with your presentation flow.

2.6 Video Box — Playback & Frame Rate
VideoBox streams video files decoded at 25 fps. The display timer also runs at 25 fps so every frame is

shown exactly once — no duplicate frames, no speed-up artefacts.

Control How

■ Play Right-click → Play

■ Pause / Resume Right-click → Pause / Resume
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■ Stop Right-click → Stop

■ Speed Right-click → Set Speed → 0.5× / 0.75× / 1× / 1.5× / 2×

Seek Add a Seek cue on the timeline and set the target time in seconds

Loop Right-click → Toggle Loop

■ Prepare presentation videos at 24 or 25 fps. Videos shot at 30 or 60 fps will play back faster than real time
because Kameleon's decoder outputs at a fixed 25 fps regardless of the source frame rate. Re-export at 25 fps in
your video editor before importing.

■ For a looping background video, right-click → Toggle Loop, then add a Play cue at t = 0. The video restarts
automatically when it ends.

2.7 Window Capture Box
Window Capture grabs any named desktop window by title and streams it onto the stage — the same

pipeline as PPT Mirror but not limited to presentation apps.

Feature Detail

Window picker Add menu → ■ Window Capture → dropdown lists all open windows

Launch command Store a shell command so Kameleon launches the target app automatically if it isn't
already running.

Auto-launch toggle Right-click → ■ Configure — disable to launch the app manually.

Restart capture Right-click → ■ Restart Capture — reconnects after the window has been closed and
reopened.

■ You can use Window Capture to bring any app you've already built (clock, countdown, scoreboard, vote
counter) onto the stage — just set its window title as the target. No integration code required.

2.8 Mind Map Node
Mind Map Nodes are presentation-native concept cards — fully cue-able actors on stage that connect to

each other via Connectors.

Gesture Effect

Drag from border zone The 18 px region around any edge is a connect-drag zone. A blue dashed rubber-band
appears. Release on empty canvas → new child node + directed Connector. Release
on existing node → Connector only.

Double-click (centre) Edit the node label. The node auto-resizes to fit the new text.

Right-click Color picker (8 pastel presets), Add Child Node, Enter/Exit/Show/Hide cues.

■ Build a concept map slide: drop a root node ('Central Idea'), drag outward 4–5 times to create branches. Assign
Enter cues and record timing — each branch flies in on cue during the presentation.

2.9 Content Rotation vs Device Rotation
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Rotate Content rotates the display inside Kameleon without affecting the device. Rotate Device (ADB

actors only) sends an OS-level rotation command so apps reflow to the new orientation on the phone. Both

work on the fly.
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3. Animations

3.1 Preset Animations
Every actor has an Enter and Exit animation binding. Available presets:

Preset Effect

ENTER_LEFT / EXIT_LEFT Slides in/out from the left edge

ENTER_RIGHT / EXIT_RIGHT Slides in/out from the right edge

ENTER_TOP / EXIT_TOP Slides in/out from the top edge

ENTER_BOTTOM / EXIT_BOTTOM Slides in/out from the bottom edge

ZOOM_IN / ZOOM_OUT Scales from/to zero at centre

FADE_IN / FADE_OUT Opacity fade

3.2 Setting an Animation Target
Directional presets require a target point — the position the actor slides to on Enter, or slides from on

Exit.

Workflow: Right-click the actor → ■ Enter Animation → choose a directional preset. The cursor

becomes a crosshair and the status bar prompts you to click the target. Click anywhere on stage; the

animation fires as a live preview.

Re-pick target: Right-click → Enter/Exit Animation → ■ Pick target on stage… to move the target

independently.

★ Pick-target mode triggers automatically when you choose any directional preset — no second menu step needed.

3.3 Record Freehand Path
Right-click → Enter/Exit Animation → ✏ Record freehand path…

• Crosshair appears — move cursor to the desired start position.

• Space — arms recording. Status bar shows ■ Recording…

• Move the cursor freely to draw the motion path.

• Space again — stops recording. Path is smoothed and stored.

• Esc at any point cancels without saving.

★ Recording a path automatically stamps two timeline cues: an enter cue at the current playhead position and a
done marker at playhead + duration — bracketing the animation window on the ruler.

■ The path is saved inside the .kpt file and plays back at the recorded speed.

3.4 On-Stage Movement — POPI & Stage Path
While an actor is already on stage you can animate it to a new position via ⇒ Stage Animation in the

right-click menu.

POPI — Pop-Out Pop-In
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A two-phase teleport effect: the actor shrinks to nothing at its current position, then grows back at the new

position.

Right-click the on-stage actor → ⇒ Stage Animation → ■ Pick POPI target… Click the destination. The

POPI fires as a live preview and a cue is stamped on the timeline.

■ POPI is ideal for relocating a large object mid-presentation — the shrink-and-grow keeps the audience eye
engaged.

Stage Path — Record Freehand
Right-click the on-stage actor → ⇒ Stage Animation → ✏ Record stage path…

• Same Space-to-arm / draw / release flow as Enter/Exit paths.

• Path starts from the object's current on-stage position.

• On release the path is smoothed, immediately previewed, and saved.

• A stage move cue and a done marker are stamped on the timeline.

★ The Dresser list shows a ⇒ suffix on objects that have a stage animation.

■ Use Stage Path to choreograph slow reveals — a content stack drifts to the side as a new object zooms in from
the right. Both can overlap on the timeline ruler.
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4. The Cue System (Manual Pacing)
The Cue System is an ordered list of scripted actions. Advancing through cues is how you control the

pace of a live presentation manually — like a clicker but for live objects.

4.1 Cue Structure

Field Description

label Display name shown on the timeline and status bar

object Which actor the cue affects

action enter · exit · zoom · edit · layer · show · hide · play · stop · seek…

params Action-specific values (preset, target position, text, time…)

4.2 Navigating Cues

Method Action

Spacebar Advance to the next cue (always works, even when nav focus is set)

→ Right arrow Advance cue — or navigate focused PDF/Stack forward (see §6)

← Left arrow Retreat cue — or navigate focused PDF/Stack backward (see §6)

■ Prev Cue button Go back one cue

■ Next Cue button Advance one cue

■ Reset button Reset to before cue #1

4.3 Building Cues
Cues can be added in three ways:

• Right-click menu: Right-click any actor → Enter Animation / Exit Animation → choose a preset. A cue
is created automatically.

• Timeline record: Press ■ Record and press Spacebar during your rehearsal — cues are stamped with
live timing as you go (see §5.4).

• AI chat: Describe what you want — "Make the Title box fly in from the left, then zoom in the chart." The
AI builds and previews all cues instantly (see §7).
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5. The Timeline (Timed / Automatic Pacing)
The Timeline adds absolute timestamps to Cue System actions so they fire automatically during

playback — turning a manually paced rehearsal into a repeatable, hands-free show.

5.1 Controls

Button / Control What it does

■ Play / ■ Pause Start or pause automatic playback. Playhead advances in real time.

■ Stop Stop playback, rewind to t = 0, restore the stage to its pre-play state.

■ Record Start the recording clock. Spacebar stamps the next cue with the elapsed time and fires it
live. Use this to rehearse.

■ From Start Move all objects back to the Dresser, rebuild the cue queue, and reset the timeline to t =
0. Use this to replay from scratch.

Green timer Shows current playhead position in seconds.

Zoom slider Stretch or compress the ruler view (20–200 px per second).

Script dropdown Select which named script is active for this tank.

+ button Add a new empty script (up to 10 per tank).

✏ button Rename the current script.

■ button Apply a timing template to the current script.

■ Loop Loop playback — restart from t = 0 when the timeline ends.

■ Ping-pong Reverse direction at each boundary — forward to end, back to start, forward again,
indefinitely. Playhead turns cyan during the reverse pass.

Scroll wheel Scrub the playhead — 1 second per notch.

Ctrl + scroll Zoom the ruler — 10 px/s per notch (range 20–200 px/s).

5.2 Filter Bar (Type Isolation)
A row of toggle buttons above the ruler — one per object type. Activate any combination to hide all other

cue types and focus on a specific set.

Button Object type

Txt Rich Text Box

Img Image Box

ADB ADB Phone

PPT PPT Mirror

PDF PDF Box

Draw Drawing Board



© 2026 Chameleon AI Technicians Ltd  ·  Registered in England & Wales Page 12

stemsee@chameleon-ai-agent-ltd.net  ·  chameleon-ai-agent-ltd.net

Tick Ticker

Win Window Capture

Conn Connector

Mind Mind Map Node

Stack Stack

Click ✕ All to clear the filter and restore the full view. A faint blue tint on the ruler reminds you a filter is

active.

Preview Mode
The ■ Preview toggle (right of ✕ All) makes playback skip any cue whose object type is hidden by the

filter. The playhead turns amber while active.

Example: Toggle ADB in the filter bar → activate ■ Preview → press ■ Play. Only ADB phone cues fire;

everything else stays still.

■ Preview mode is a runtime mask only — it does not change or delete any cues. Save normally; all cues are
preserved.

5.3 The Ruler
The fixed-centre playhead stays at the horizontal midpoint while the ruler scrolls leftward beneath it.

Upcoming cues approach from the right; past cues drift off to the left.

Interaction Effect

Click ruler Seek playhead to that time

Drag cue arrow Reposition a cue's timestamp; list re-sorts on release

Hover over cue arrow Popup shows full label and timestamp

Right-click cue arrow Edit time numerically / rename label / delete cue

Right-click empty ruler Set total duration OR Add AI Stage Block…

Scroll wheel Scrub playhead — 1 second per notch

Ctrl + scroll Zoom ruler — 10 px/s per notch

5.4 Recording a Timed Show
• Step 1. Set up your cues first (right-click menus or AI).

• Step 2. Press ■ Record. The timer starts from 0.

• Step 3. Present naturally. Press Spacebar at each transition — the elapsed time is stamped and the
cue fires live.

• Step 4. Press ■ again (or ■ Stop) when done.

• Step 5. Fine-tune by dragging markers or right-clicking → Edit time.

• Step 6. Press ■ Play — the show runs automatically.

■ Recorded timing is exactly what the audience will see during automated replay, because the cue fires live as you
stamp it.
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5.5 Multi-Script Timelines
A single tank can hold up to 10 named scripts — independent sets of timed cues sharing the same stage

objects. Use scripts for alternate versions: a 30-minute full show, a 5-minute highlights cut, a Q&A; order,

etc.

Action How

Add a script Click + in the timeline bar. Enter a name.

Switch scripts Open the Script dropdown and select a name.

Rename Click ✏ to rename the current script.

Delete Right-click the script name in the dropdown.

■ Objects, positions, and animation bindings are shared across all scripts. Only the timing and sequence of cues
differs between them.

5.6 AI Stage Blocks — Generative Animation
An AI Stage Block is a coloured band on the timeline. When the playhead enters it, Kameleon drives all

on-stage objects through a repeating choreography pattern. Objects return to their positions when the

block ends.

Style Pattern

orbit Objects rotate as a ring around the stage centre

snake Objects trace a figure-8 path

random Each object drifts to a random position every beat

focus One object enlarges to centre stage; the rest shrink back. Cycles through all.

Add a block: Right-click an empty area of the ruler → ✦ Add AI Stage Block… Enter a name, duration,

and style.

Edit a block: Right-click the coloured band → Change style… / Set speed… / Delete AI block.

■ For an interval break: add a 15-minute AI Stage Block with style 'orbit' at the break start time. Objects orbit
continuously and snap back when the break ends.

■ Combine AI Stage Blocks with ping-pong for a hypnotic loop: objects orbit forward, retrace in reverse,
indefinitely.

5.7 Timeline Templates
Press ■ Templates to apply a pre-built timing framework:

Template Cue slots

Short Pitch (5 min) Opening → Problem → Solution → Demo → Proof → Ask (6)

Conference Keynote (20 min) Opening → Problem → Solution → Demo → Benefits → Case study → CTA →
Q&A; (8)
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University Lecture (50 min) Welcome → Objectives → 3 Concepts → Example → Activity → Q&A; (8)

Workshop (90 min) Welcome → Warm-up → 2 Exercises + Debriefs → Break → Wrap-up (8)

Conference Half-Day (3 hrs) Opening → 3 Talks → Break → Panel → Wrap-up → Networking (8)

Existing cues are retimed to the template slots. An empty script gets placeholder markers so you can see

the scaffold first.

■ Apply a template to an empty script, then record over it — the markers keep your talk on time.

5.8 Loading a Tank for Playback
When you open a .kpt file via File → Open Tank:

• All objects are placed in the Dresser (not on stage).

• The Cue System is rebuilt from saved Z-order — lowest Z first.

• Each actor's saved enter animation is used for its cue.

• The timeline resets to t = 0.

Playback mode How

Manual (clicker) Press Space or → to bring each actor on stage one at a time

Automatic Press ■ on the timeline bar — fires all timed cues in sequence

Press ■ From Start at any time to return to this clean state.
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6. Navigation Focus & Present Mode
The navigation focus system lets arrow keys control the content of PDF viewers and image stacks on

stage — independently of the cue queue. Present Mode locks the stage for distraction-free presenting.

6.1 Navigation Focus
Any PDF Box or Stack can receive navigation focus. When focused, ← → navigate its pages or slots

instead of the cue queue.

Action Effect

Click a PDF / Stack Gives focus — a solid cyan ring (3 px) appears. Status bar shows: ← → navigating:
ObjectName

← / → arrow keys Navigate the focused object. If nothing is focused, arrows drive the cue queue as
usual.

Space Always advances the cue queue, regardless of nav focus.

Click another object Transfers focus. Previous cyan ring disappears.

■ The on-screen ■■ arrow buttons on a PDF Box both focus and navigate in one click.

6.2 Multi-Object Navigation (Ctrl+Click)
Hold Ctrl and click a PDF or Stack to add it to the navigation group. All grouped objects advance

simultaneously.

Action Effect

Ctrl+Click (new) Add to nav group — cyan ring appears

Ctrl+Click (existing) Remove from nav group — cyan ring disappears

Plain click Replace group with just this one object

← / → with group All grouped objects navigate together

Example: Two image stacks side-by-side comparing before/after. Ctrl+Click both — one → key advances

both in sync.

6.3 Present Mode (F5)
Press F5 (or ■ Present in the toolbar) to enter full-screen presentation mode.

Element In Present Mode

Dresser panel Hidden

Timeline bar Hidden

Toolbar Hidden

Menu bar Hidden
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Status bar Hidden

Window Full-screen

Object selection Disabled — objects cannot be selected or resized

Object movement Still allowed — drag to reposition during the live show

Nav focus Still works — click PDF/Stack to focus; Ctrl+Click for groups

Press Esc to exit Present Mode and restore all editing.
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7. AI-Assisted Control
Every Kameleon object and action can be controlled through the Chameleon AI chat in real time. You

don't need to learn any commands — just describe what you want in plain English.

7.1 What You Can Ask the AI to Do

Category Examples

Add objects "Add a text box saying 'Welcome' in the top-left" · "Put a PDF of slides.pdf on stage"

Show & animate "Bring the Title box in from the left" · "Fade out the phone and zoom in the chart"

Edit content "Change the heading to Quarterly Results" · "Swap the image to logo_v2.png"

Video & PDF "Play the video" · "Pause it" · "Jump to 30 seconds" · "Go to page 5 of the PDF"

Build the timeline "Add enter cues for every object, left to right" · "Set up a 20-minute keynote template"

Split-stage "Load intro.kpt into the left half and phone.kpt into the right" · "Swap the top-left panel to
stats.kpt"

Save & load "Save the presentation as demo_v2.kpt" · "Open last_show.kpt"

7.2 Tips for Talking to the AI
• Refer to objects by the name shown in the Dresser list.

• Relative instructions work: "move it slightly to the right" or "make it a bit bigger."

• Chain requests in one sentence: "Hide the phone, bring in the chart, then play the video."

• Ask the AI to set up an entire scene: "Set up a split screen with a PDF on the left and a live phone on
the right."

■ Give your actors descriptive names when you add them (e.g. 'Intro Slide', 'Demo Phone') rather than leaving
default IDs — the AI will refer to them by name in its responses.
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8. Kameleon Remote — Android Companion App
The Kameleon Remote app turns any Android phone into a wireless control surface for Kameleon

Presenter. It connects over Wi-Fi to the Presenter's built-in WebSocket server and provides five control

panels in a single tabbed interface.

8.1 Connecting

Ste
p

Action

1 Start Kameleon Presenter on the host computer. The WebSocket remote server starts automatically on port
9000.

2 Open the Kameleon Remote app on your Android device.

3 Tap ■ Settings (gear icon) in the top-right corner to open the Connection screen.

4 Enter the IP address of the host computer and the port (default 9000). Tap Connect.

5 The connection badge in the app bar turns green when connected. Tap the badge to disconnect.

■ Find the host IP on Linux / macOS with ip a or ifconfig, on Windows with ipconfig. Both devices must be
on the same Wi-Fi network.

Tap ■ Refresh (top-right toolbar) at any time to re-sync stage object lists and stack names from the

presenter.

8.2 Tab — Cue (Show Control)
The Cue tab is the primary show-control panel. It provides:

Control Function

START SHOW Plays the full cue sequence from the current position — identical to pressing Space on the
presenter machine.

PAUSE Pauses timeline playback.

STOP Stops playback and returns all objects to the Dresser.

PREV / NEXT Step backward or forward through the cue queue. PREV is disabled when at the start;
NEXT is disabled at the end.

Cue display Shows the current cue label and progress bar (N / total).

Fullscreen toggle Quick-access chip — toggles Present Mode on the presenter.

Reset Stage Quick-access chip — clears the stage and returns all objects to the Dresser.

■ Tap Refresh cue info if the cue counter gets out of sync — it re-polls the presenter for the current cue state.

8.3 Tab — Stack
The Stack tab controls any KameleonStack on stage.
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Control Function

Stack chips The app auto-discovers all stacks on stage. Tap a chip to select that stack.

Stack Name field Type a stack name directly if the chip list is empty.

Mode selector Manual — advance slots one by one. Auto — slots advance on their timer automatically.

Play / Pause / Stop Control auto-timer playback.

Prev / Max / Next Navigate slots. Max toggles fullscreen for the stack.

Goto item Type a 1-based slot number and tap Go to jump directly to that slot.

Progress bar Fills as the current slot's timer elapses. Grey = paused; green = playing.

Queued badge Orange badge shows how many peer-submitted slots are waiting for approval.

8.4 Tab — PDF
The PDF tab controls any PDF Box on stage.

Control Function

PDF object chips Auto-discovered PDF actors. Tap to select.

Actor Name field Type the PDF actor name directly.

Prev / Next Navigate pages.

Goto Page Type a page number and tap Go.

8.5 Tab — Video
The Video tab controls any Video Box on stage.

Control Function

Video object chips Auto-discovered Video actors. Tap to select.

Actor Name field Type the Video actor name directly.

Play / Pause / Stop Transport controls.

Seek Type a time in seconds and tap Seek.

Quick Seek −30 s / −10 s / +10 s / +30 s jump buttons.

8.6 Tab — Files
The Files tab shows all .kpt tank files on the presenter machine and provides general presenter controls.

Control Function

Tank list All .kpt files found by the presenter. Tap Load on any file to open it.

Refresh Re-polls the presenter for the current file list.

Save Current Saves the currently open tank file on the presenter.

Toggle Full Toggles Present Mode (full-screen) on the presenter.
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Dashboard Switches the presenter to dashboard layout.

Focus Switches the presenter to focus layout.

8.7 8K Stage Trackpad
Tap the green Touch App floating action button (bottom-right) to open the Stage Trackpad sheet. The

trackpad renders a proportional map of the full 1920 × 1080 logical stage. Tap anywhere to send a stage

tap at the corresponding logical coordinate — useful for clicking objects or selecting items without touching

the presenter machine.

The sheet also contains a Toggle Fullscreen button for quick access to Present Mode from any tab.

8.8 Permissions & Capabilities
If the presenter has device permission restrictions configured (Remote → Manage Device

Permissions…), the app respects them automatically. Restricted tab icons dim to white/grey to signal that

those controls are locked for the current device. The Cue tab shows the allowed capability list at the

bottom.

■ Install the APK on multiple phones — each gets its own permission profile so the presenter can control exactly
what each operator sees.
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9. Split-Stage & Region Channels
Kameleon can divide the stage into named regions and load independent .kpt files into each one. This

enables split-screen layouts, multi-module shows, and — on 4K/8K displays — a full broadcast-style

multi-panel compositor.

9.1 Built-In Regions

Region name Area of stage

FULL Whole stage (default — no split)

LEFT Left half

RIGHT Right half

TOP Top half

BOTTOM Bottom half

QUAD_TL Top-left quarter

QUAD_TR Top-right quarter

QUAD_BL Bottom-left quarter

QUAD_BR Bottom-right quarter

■ On a 4K display each quarter region renders at full 1920 × 1080 native pixels. No configuration needed — the
stage scales automatically.

8.2 Setting Up a Split Layout
Tell the AI what you want in plain English:

• "Load intro.kpt into the left half of the stage."

• "Load phone.kpt into the right half, preserving its aspect ratio."

• "Load keynote.kpt into the top-left quarter and drawing.kpt into the bottom-right."

Kameleon scales all object positions and sizes to fit the target region automatically. When two tanks share

the stage, each is loaded with an internal name prefix so objects from different files never conflict.

★ You can define custom regions of any size: "Create a banner region at the top (10% of stage height) and a main
content region below it."

8.3 Region Overlay
Ask the AI to "show the region overlay" at any time to see a labelled dashed grid of all regions drawn

directly on the stage — useful while composing a split layout. Ask it to "hide the region overlay" before

presenting.

8.4 Region Channels — Queued Content
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A Region Channel is a queue of .kpt files for one region. Only the active slot is visible on stage; all

other slots are pre-loaded silently for instant, zero-latency swaps. Up to 4 regions can run

simultaneously.

Set up and manage the queue by telling the AI:

• "Load intro.kpt into the top-left quarter, then queue stats.kpt and sponsor.kpt after it."

• "Swap the top-left panel to the next slot."

• "Jump the top-right panel back to the first slot."

• "Swap the left panel to the next file, exit right, enter from the left."

■ All queued files are pre-loaded — swapping is instant with no loading screen. You can specify entrance and exit
animations for each swap.

8.5 Four-Quadrant Show
A typical setup for a large 4K display:

• "Load keynote1.kpt into the top-left, live_phone.kpt into the top-right, userguide.kpt into the bottom-left,
and drawing.kpt into the bottom-right."

• Queue backup files for each quadrant.

• During the show, swap panels with a single spoken instruction.

All files are pre-loaded. Four panels are live simultaneously. Each swap is instant with a cinematic

transition — no loading screen, no interruption.

8.6 Saving a Split-Stage Show
• Set up your regions and load all files.

• Show the region overlay, verify positions, then hide it.

• Press ■ Record and rehearse panel swaps and cue transitions.

• Save: File → Save Tank — all regions and queues are bundled into one .kpt file.

■ Load the combined .kpt on any machine and press ■ Play — everything is self-contained.
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10. Keyboard Shortcuts

Shortcut Context Action

Space Stage Advance cue queue / stamp timeline cue in record mode

→ Right arrow Stage Navigate focused PDF/Stack forward — or advance cue
queue

← Left arrow Stage Navigate focused PDF/Stack backward — or retreat cue
queue

Click PDF / Stack Stage Give that object navigation focus (cyan ring)

Ctrl+Click PDF / Stack Stage Add / remove from multi-object nav group

Esc Stage Cancel path recording or animation pick

Space Path record Arm recording, then stop recording

Delete Stage (edit) Delete selected actor(s)

F5 Presenter Toggle Present / Edit mode

Esc Present mode Exit Present mode, return to Edit mode

Ctrl+Shift+K Main window Open / raise Kameleon Presenter

Ctrl+N Presenter New Tank (clears stage)

Ctrl+O Presenter Open Tank

Ctrl+S Presenter Save Tank

Ctrl+Shift+S Presenter Save Tank As…

Ctrl+Alt+S Presenter Quick Save Config (layout snapshot)

Ctrl+Alt+R Presenter Restore Config… (pick a saved snapshot)

Ctrl+Shift+E Presenter Export active timeline script to .ktl file

Ctrl+Shift+I Presenter Import a .ktl timeline script

Double-click Text box Open inline HTML editor

Double-click ADB phone Toggle Interact Mode

Esc / Home / Menu ADB interact Back / Home / Recent Apps on phone

Scroll wheel Timeline Scrub playhead — 1 s per notch

Ctrl + scroll Timeline Zoom ruler — 10 px/s per notch (20–200 range)

Right-click dresser Dresser Preview / Duplicate / Reserve / Remove

Right-click on-stage Stage Stage Animation → POPI target or stage path
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11. Saving and Loading (.kpt Files)
A Tank file (.kpt) is a single archive containing everything in your presentation: all objects with their

positions, sizes, and animation bindings; all timeline scripts; and any embedded images.

Action Menu / Shortcut

Save File → Save Tank (Ctrl+S)

Save As File → Save Tank As… (Ctrl+Shift+S)

Open File → Open Tank (Ctrl+O)

■ ADB phone actors, PPT Mirror actors, and Drawing Board strokes are runtime-only — their live content is not
saved in the tank. Only the connection address or window title is preserved.

11.1 Timeline Script Export / Import
Timeline cue sequences can be exported to a .ktl file and imported into any tank — useful for reusing

timing across multiple shows.

• Export: Ctrl+Shift+E — saves the active script as a .ktl file.

• Import: Ctrl+Shift+I — loads a .ktl file into the current tank.

• Both support optional AES-256 password encryption for sensitive cue data.

11.2 Tank Encryption
For sensitive presentations: File → Encrypt Tank re-saves the .kpt with AES-256-GCM encryption. A

password is required to open it. File → Decrypt Tank removes the encryption.

11.3 Auto-Save Config Snapshots
Kameleon automatically saves a layout snapshot on exit and every 5 minutes. Up to 10 snapshots are

stored inside the .kpt file.

• Quick Save Config: Ctrl+Alt+S — saves a named snapshot immediately.

• Restore Config…: Ctrl+Alt+R — browse and restore any saved snapshot.

11.4 Startup Mode
Open Settings → On Startup to choose:

Option Effect

Start empty Default — opens with a blank stage each launch.

Open last file Automatically loads the most recently used .kpt file on startup.

11.5 Interface Language
Open Settings → ■ Language and pick from 25 supported languages. All menus and status messages

update immediately — no restart required.
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Language Code

English en (default)

Français / Deutsch / Español / Português / Italiano fr / de / es / pt / it

■■■■■■■ / ■■ / ■■■ / ■■■ ar / zh / ja / ko

■■■■■■■ / Ελληνικ■ / Polski / Român■ / ■■■■■■■■■ ru / el / pl / ro / bg

■■■■■■■■■■ / Nederlands / Svenska / Norsk / Dansk uk / nl / sv / nb / da

Ti■ng Vi■t / Kiswahili / Cymraeg / ■■■■■■■ / Türkçe vi / sw / cy / th / tr

The first time you select a language, translations are fetched in the background (approximately 60

seconds). The status bar shows a progress message; Kameleon remains fully usable during this time.

Once cached, switching to that language is instant.

11.6 Installation
Kameleon Presenter requires Python 3.10+. Install all Python dependencies with:

pip install -r requirements_presenter.txt

External tools required for live capture features (install via your system package manager):

Tool Purpose

ffmpeg Video playback, ADB streaming, and window/PPT capture.

adb Android device streaming. Part of Android SDK platform-tools.

ydotool Wayland (Linux only): PPT slide-advance key injection.

■ ffmpeg is required for ADB mirroring, video playback, and PPT/Window capture. A warning dialog lists any
missing tools on first launch.

11.7 File Association — Open .kpt by Double-Click
Run the platform setup script once to register .kpt as a file type. After that, double-clicking any .kpt

opens it in Kameleon Presenter directly.

Platform Script to run once

Linux bash kpt_install_assoc.sh

Windows PowerShell -File kpt_install_assoc.ps1

macOS bash kpt_install_assoc_macos.sh

★ v2.2: ADB Phone timeline cues (■ Restart Stream, ■ Open URL, ■ Launch App) — right-click any ADB actor →
Add Cue to Timeline. Stack from Folder — pick a directory of numerically-prefixed files (images, video, PDF, text,
HTML) to build a typed multi-slot stack in one step. Interface language selector (25 languages) with non-blocking
background translation.

★ v2.1: Mind Map Node; Window Capture Box; Connector style improvements (independent line/arrow colours,
solid/dashed/dotted, width 1–6); Timeline Script export/import (.ktl); on-demand tank encryption; Drawing Board
Add Clear Cue; Show/Hide cues for all object types; 25 fps pipeline throughout all capture actors.
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★ v2.0: Windows, macOS, and Linux Wayland fully supported. TickerBox gains play/pause/stop,
text/colour/font/size editing, direction toggle, and content rotation. 10-slot auto-save config system added.

★ v1.9: Stage Path and POPI on-stage animations. Right-click any on-stage object → ⇒ Stage Animation. Dresser
shows ⇒ suffix on objects with a stage animation configured.

★ v1.8: Timeline scroll-wheel scrub; Ctrl+scroll ruler zoom; Dresser right-click menu; live image preview in Add
Image dialog; animation target unified — Dresser preview and Timeline playback use the same stored target.

★ v1.7: Ping-pong timeline loop. Cues fire their opposite action on the reverse pass. Playhead turns cyan with a
downward triangle.

★ v1.6: Preview mode in filter bar — playback skips hidden cue types; playhead turns amber when Preview is
active.

★ v1.5: Fixed-centre scrolling playhead; filter bar for per-type isolation; hover popup shows full cue label.
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12. Quick-Start Checklist
First presentation in 5 minutes:

• Open Kameleon Presenter: Ctrl+Shift+K or the Tools menu.

• Drag objects from the Dresser onto the Stage, or tell the AI: "Add a text box saying Hello World in the
centre."

• Right-click an object → Enter Animation → choose a preset.

• Press Space to step through cues, or ■ Play to run the timeline.

• Save: File → Save Tank.

Playing back an existing .kpt file:

• File → Open Tank → select your .kpt file.

• Objects load into the Dresser automatically.

• Press Space or ■ Next Cue to bring each actor on stage with its enter animation.

• Or press ■ Play on the timeline bar for automatic playback.

• Press ■ From Start at any time to replay from scratch.

Navigating a PDF or image stack:

• Click the PDF Box or Stack to give it navigation focus (cyan ring).

• Use ← → to flip pages or advance slots.

• Ctrl+Click a second object to navigate both simultaneously.

• Press Space to advance the cue queue independently of nav focus.

Recording a timed show:

• Build your objects and cues (or ask the AI to do it).

• Press ■ Record on the timeline bar.

• Speak naturally and press Space at each transition.

• Press ■ to stop. Drag the ▲ markers to fine-tune.

• Press ■ Play — your show runs automatically.

Presenting without accidental edits:

• Press F5 to enter Present Mode (full screen).

• Objects cannot be selected or resized — only dragged.

• Nav focus and Space/arrow keys still work normally.

• Press Esc to return to Edit mode.

Setting up a split-stage show:

• Tell the AI: "Load intro.kpt into the left half and phone.kpt into the right."

• Tell the AI: "Show the region overlay" to check the layout.

• Tell the AI: "Hide the overlay" before you go live.

• During the show: "Swap the left panel to the next file."

Letting AI run the whole show:
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• Make sure Chameleon AI IDE is open alongside Kameleon Presenter.

• Describe what you want in the AI chat — it handles the rest.

• "Load slides.kpt into the left half, stream the phone on the right, navigate to our website, then step
through the left-side cues one by one."

■ Name your actors descriptively when you add them. The AI, the timeline, and the status bar all refer to objects by
name — clear names make every part of the workflow easier to follow.
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Legal Notice & Disclaimer

This document is part of an active testing and development process. Content has been produced with the assistance

of AI tools and may contain inaccuracies, incomplete information, or placeholder text. Nothing in this document

constitutes a final product offer, warranty, or legal commitment.

Licensing terms are pending finalisation. No software licence — commercial, personal, or otherwise — is granted or

implied by this document. Do not make business decisions based on information shown here.

This document is confidential and intended for use by licensed users and authorised evaluators only. Unauthorised

reproduction or distribution is strictly prohibited.

Kameleon Presenter is a component of Chameleon AI IDE, developed and maintained by Chameleon AI Technicians Ltd. All product

names, logos, and brands are property of their respective owners.


